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Introduction
The Microsoft Office Specialist (MOS) certification program has been designed to validate 
your knowledge of and ability to use programs in the Microsoft Office 2013 suite of pro-
grams, Microsoft Office 365, and Microsoft SharePoint. This book has been designed to 
guide you in studying the types of tasks you are likely to be required to demonstrate in 
Exam 77-427: Microsoft Excel 2013 Expert Part One, and Exam 77-428: Microsoft Excel 
2013 Expert Part Two.

See Also For information about the tasks you are likely to be required to demonstrate in 
Exam 77-420: Microsoft Excel 2013, see MOS 2013 Study Guide for Microsoft Excel by Joan 
Lambert (Microsoft Press, 2013).

Who this book is for
MOS 2013 Study Guide for Microsoft Excel Expert is designed for experienced Excel users 
seeking Microsoft Office Specialist Expert certification in Excel 2013. This certification re-
quires that the candidate pass two exams. This book covers the objectives of both exams.

MOS exams for individual programs are practical rather than theoretical. You must dem-
onstrate that you can complete certain tasks or projects rather than simply answering 
questions about program features. The successful MOS certification candidate will have 
at least six months of experience using all aspects of the application on a regular basis; 
for example, using Excel at work or school to manage and share workbooks, apply and 
share custom formatting, present data in PivotTables and Pivot Charts, create models 
and scenarios, and create advanced formulas by using functions.

As a certification candidate, you probably have a lot of experience with the program you 
want to become certified in. Many of the procedures described in this book will be famil-
iar to you; others might not be. Read through each study section and ensure that you are 
familiar with not only the procedures included in the section, but also the concepts and 
tools discussed in the review information. In some cases, graphics depict the tools you 
will use to perform procedures related to the skill set. Study the graphics and ensure that 
you are familiar with all the options available for each tool.



viii  Introduction

How this book is organized
The exam coverage is divided into chapters representing broad skill sets that correlate 
to the functional groups covered by the exams, and each chapter is divided into sections 
addressing groups of related skills that correlate to the exam objectives. Each section 
includes review information, generic procedures, and practice tasks you can complete on 
your own while studying. When necessary, we provide practice files you can use to work 
through the practice tasks. You can practice the procedures in this book by using the 
practice files supplied or by using your own files.

Throughout this book, you will find Strategy tips that present information about the 
scope of study that is necessary to ensure that you achieve mastery of a skill set and 
are successful in your certification effort.

The exam objectives are divided into four functional groups. The mapping of the exam 
objectives to the certification exams is shown in the following table.

Functional group Objectives covered by 
Exam 77-427

Objectives covered by 
Exam 77-428

1 Manage and Share 
Workbooks

1.3 Manage Workbook Changes 1.1 Manage Multiple Workbooks
1.2 Prepare a Workbook Review

2 Apply Custom 
Formats and Layouts

2.2 Apply Advanced Conditional 
Formatting and Filtering
2.4 Prepare a Workbook 
for Internationalization and 
Accessibility

2.1 Apply Custom Data Formats
2.3 Apply Custom Styles and 
Templates

3 Create Advanced 
Formulas

3.2 Look Up Data with Functions
3.3 Apply Advanced Date and 
Time Functions

3.1 Apply Functions in Formulas
3.4 Create Scenarios

4 Create Advanced 
Charts and Tables

4.1 Create Advanced Chart 
Elements 
4.2 Create and Manage 
PivotTables

4.3 Create and Manage Pivot 
Charts

Candidates must pass both exams to earn the Microsoft Office Specialist Expert certifica-
tion in Excel 2013.

Download the practice files
Before you can complete the practice tasks in this book, you need to download the 
book’s practice files to your computer. These practice files can be downloaded from 
the following page: http://aka.ms/mosExcelExp2013/files
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Important The Excel 2013 program is not available from this website. You should 
purchase and install that program before using this book.

If you would like to be able to refer to the completed versions of practice files at a later 
time, you can save the practice files that you modify while working through the exercises 
in this book. If you save your changes and later want to repeat the exercise, you can 
download the original practice files again.

The following table lists the practice files for this book.

Folder and functional group Files
MOSExcel2013Expert\Objective1
1 Manage and share workbooks

ExcelExpert_1-1a.xltx
ExcelExpert_1-1b.accdb
ExcelExpert_1-1c.xlsx
ExcelExpert_1-1d.xlsx
ExcelExpert_1-2.xlsx
ExcelExpert_1-3a.xlsx
ExcelExpert_1-3b.xlsx
ExcelExpert_1-3c.xlsx
ExcelExpert_1-3d.xlsx
ExcelExpert_1-3e.xlsx

MOSExcel2013Expert\Objective2
2 Apply custom formats and layouts

ExcelExpert_2-1.xlsx
ExcelExpert_2-2.xlsx
ExcelExpert_2-3.xlsx
ExcelExpert_2-4.xlsx

MOSExcel2013Expert\Objective3
3 Create advanced formulas

ExcelExpert_3-1a.xlsx
ExcelExpert_3-1b.xlsx
ExcelExpert_3-2.xlsx
ExcelExpert_3-3.xlsx
ExcelExpert_3-4a.xlsx
ExcelExpert_3-4b.xlsx
ExcelExpert_3-4c.xlsx
ExcelExpert_3-4d.xlsx

MOSExcel2013Expert\Objective4
4 Create advanced charts and tables

ExcelExpert_4-1.xlsx
ExcelExpert_4-2a.xlsx
ExcelExpert_4-2b.xlsx
ExcelExpert_4-3.xlsx
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Adapting exercise steps

The screen images shown in this book were captured at a screen resolution of 
1024 × 768, at 100 percent magnification. If your settings are different, the rib-
bon on your screen might not look the same as the one shown in this book. For 
example, you might have more or fewer buttons in each of the groups, the buttons 
you have might be represented by larger or smaller icons than those shown, or the 
group might be represented by a button that you click to display the group’s com-
mands. As a result, exercise instructions that involve the ribbon might require a 
little adaptation. Our instructions use this format:

➜ On the Insert tab, in the Illustrations group, click the Chart button.

If the command is in a list or on a menu, our instructions use this format:

➜ On the Home tab, in the Editing group, click the Find arrow and then, on the 
Find menu, click Advanced Find.

Tip On subsequent instances of instructions located on the same tab or in 
the same group, the instructions are simplified to reflect that we’ve already 
established the working location.

If differences between your display settings and ours cause a button to appear 
differently on your screen than it does in this book, you can easily adapt the steps 
to locate the command. First click the specified tab, and then locate the specified 
group. If a group has been collapsed into a group list or under a group button, 
click the list or button to display the group’s commands. If you can’t immediately 
identify the button you want, point to likely candidates to display their names in 
ScreenTips.

If you prefer not to have to adapt the steps, set up your screen to match ours while 
you read and work through the exercises in this book.

In this book, we provide instructions based on the traditional keyboard and mouse 
input methods. If you’re using the program on a touch-enabled device, you might 
be giving commands by tapping with a stylus or your finger. If so, substitute a tap-
ping action any time we instruct you to click a user interface element. Also note 
that when we tell you to enter information, you can do so by typing on a keyboard, 
tapping an on-screen keyboard, or even speaking aloud, depending on your com-
puter setup and your personal preferences.



 Introduction  xi

Get support and give feedback
The following sections provide information about getting help with this book and 
 contacting us to provide feedback or report errors.

Errata
We’ve made every effort to ensure the accuracy of this book and its companion con-
tent. Any errors that have been reported since this book was published are listed on 
our Microsoft Press site:

http://aka.ms/mosExcelExp2013/errata

If you find an error that is not already listed, you can report it to us through the same page.

If you need additional support, send an email message to Microsoft Press Book Support at:

mspinput@microsoft.com

Please note that product support for Microsoft software is not offered through the pre-
ceding addresses.
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We want to hear from you
At Microsoft Press, your satisfaction is our top priority, and your feedback our most valu-
able asset. Please tell us what you think of this book at:

http://www.microsoft.com/learning/booksurvey

The survey is short, and we read every one of your comments and ideas. Thanks in 
 advance for your input!

Stay in touch
Let’s keep the conversation going! We’re on Twitter at:

http://twitter.com/MicrosoftPress
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Taking a Microsoft Office 
Specialist exam

Desktop computing proficiency is increasingly important in today’s business world. When 
screening, hiring, and training employees, employers can feel reassured by relying on the 
objectivity and consistency of technology certification to ensure the competence of their 
workforce. As an employee or job seeker, you can use technology certification to prove 
that you already have the skills you need to succeed, saving current and future employ-
ers the time and expense of training you.

Microsoft Office Specialist certification
Microsoft Office Specialist certification is designed to assist employees in validating their 
skills with Office programs. The following certification paths are available:

l A Microsoft Office Specialist (MOS) is an individual who has demonstrated profi-
ciency by passing a certification exam in one or more Office programs, including 
Microsoft Word, Excel, PowerPoint, Outlook, Access, OneNote, or SharePoint.

l A Microsoft Office Specialist Expert (MOS Expert) is an individual who has taken 
his or her knowledge of Office to the next level and has demonstrated by passing 
the required certification exams that he or she has mastered the more advanced 
features of Word or Excel.

Selecting a certification path
When deciding which certifications you would like to pursue, you should assess the 
following:

l The program and program version or versions with which you are familiar

l The length of time you have used the program and how frequently you use it

l Whether you have had formal or informal training in the use of that program

l Whether you use most or all of the available program features

l Whether you are considered a go-to resource by business associates, friends, and 
family members who have difficulty with the program
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Candidates for MOS-level certification are expected to successfully complete a wide 
range of standard business tasks, such as formatting a document or worksheet and its 
content; creating and formatting visual content; or working with SharePoint lists, librar-
ies, Web Parts, and dashboards. Successful candidates generally have six or more months 
of experience with the specific Office program, including either formal, instructor-led 
training or self-study using MOS-approved books, guides, or interactive computer-based 
materials.

Candidates for MOS Expert–level certification are expected to successfully complete 
more complex tasks that involve using the advanced functionality of the program. 
Successful candidates generally have at least six months, and may have several years, 
of experience with the programs, including formal, instructor-led training or self-study 
using MOS-approved materials.

Test-taking tips
Every MOS certification exam is developed from a set of exam skill standards (referred to 
as the objective domain) that are derived from studies of how the Office programs are 
used in the workplace. Because these skill standards dictate the scope of each exam, they 
provide critical information about how to prepare for certification. This book follows the 
structure of the full objective domain for Excel Expert certification; see “How this book is 
organized” in the Introduction for more information.

The MOS certification exams are performance based and require you to complete 
business-related tasks or projects in the program for which you are seeking certification. 
For example, you might be presented with a file and told to do something specific with it, 
or presented with a sample document and told to create it by using resources provided for 
that purpose. Your score on the exam reflects how well you perform the requested tasks or 
complete the project within the allotted time.

Here is some helpful information about taking the exam:

l Keep track of the time. Your exam time does not officially begin until after you 
finish reading the instructions provided at the beginning of the exam. During the 
exam, the amount of time remaining is shown at the bottom of the exam interface. 
You can’t pause the exam after you start it.
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l Pace yourself. At the beginning of the exam, you will receive information about the 
questions or projects that are included in the exam. Some questions will require 
that you complete more than one task. Each project will require that you complete 
multiple tasks. During the exam, the amount of time remaining to complete the 
questions or project, and the number of completed and remaining questions if 
 applicable, is shown at the bottom of the exam interface.

l Read the exam instructions carefully before beginning. Follow all the instructions 
provided completely and accurately.

l Enter requested information as it appears in the instructions, but without duplicat-
ing the formatting unless you are specifically instructed to do so. For example, the 
text and values you are asked to enter might appear in the instructions in bold 
and underlined text, but you should enter the information without applying these 
formats.

l Close all dialog boxes before proceeding to the next exam question unless you are 
specifically instructed not to do so.

l Don’t close task panes before proceeding to the next exam question unless you are 
specifically instructed to do so.

l If you are asked to print a document, worksheet, chart, report, or slide, perform the 
task, but be aware that nothing will actually be printed.

l When performing tasks to complete a project-based exam, save your work 
frequently.

l Don’t worry about extra keystrokes or mouse clicks. Your work is scored based on 
its result, not on the method you use to achieve that result (unless a specific method 
is indicated in the instructions).

l If a computer problem occurs during the exam (for example, if the exam does not 
respond or the mouse no longer functions) or if a power outage occurs, contact a 
testing center administrator immediately. The administrator will restart the com-
puter and return the exam to the point where the interruption occurred, with your 
score intact.

Strategy This book includes special tips for effectively studying for the Microsoft Office 
Specialist exams in Strategy paragraphs such as this one.
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Certification benefits
At the conclusion of the exam, you will receive a score report, indicating whether you 
passed the exam. If your score meets or exceeds the passing standard (the minimum 
required score), you will be contacted by email by the Microsoft Certification Program 
team. The email message you receive will include your Microsoft Certification ID and 
links to online resources, including the Microsoft Certified Professional site. On this site, 
you can download or order a printed certificate, create a virtual business card, order an 
ID card, view and share your certification transcript, access the Logo Builder, and access 
other useful and interesting resources, including special offers from Microsoft and affili-
ated companies.

Depending on the level of certification you achieve, you will qualify to display one of 
three logos on your business card and other personal promotional materials. These logos 
attest to the fact that you are proficient in the applications or cross-application skills neces-
sary to achieve the certification.

Using the Logo Builder, you can create a personalized certification logo that includes 
the MOS logo and the specific programs in which you have achieved certification. If you 
achieve MOS certification in multiple programs, you can include multiple certifications in 
one logo.

For more information
To learn more about the Microsoft Office Specialist exams and related courseware, visit:

http://www.microsoft.com/learning/en/us/mos-certification.aspx
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 3 Create advanced  
  formulas
The skills tested in this section of the Microsoft Office Specialist Expert exams for 
Microsoft Excel 2013 relate to the creation of sophisticated formulas. Specifically, 
the  following objectives are associated with this set of skills:

3.1 Apply functions in formulas
3.2 Look up data by using functions
3.3 Apply advanced date and time functions
3.4 Create scenarios

Most users of Excel have created formulas that include one or more of the most com-
monly used Excel functions, such as SUM, AVERAGE, COUNT, MAX, and MIN. However, 
Excel provides functions for other very specific operations.

This chapter guides you in studying methods for these other operations, such as calculat-
ing dates and times, performing statistical or financial analysis, working with text strings, 
and looking up values.

Practice Files To complete the practice tasks in this chapter, you need the practice 
files contained in the MOSExcel2013Expert\Objective3 practice file folder. For more 
information, see “Download the practice files” in this book's Introduction.

3.1 Apply functions in formulas 
Menus in the Function Library group on the Formulas tab offer functions grouped by 
type, including a More Functions menu. Depending on your screen size and resolution, 
some of the menus might include text labels, but if not, point to the menu to display a 
ScreenTip that has a thumbnail explanation, which might be all the information you need 
to proceed.
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When you select a function from one of the menus, the Function Arguments dialog box 
opens, which you use to enter the information (called arguments) that the function needs 
to perform its calculations. The Function Arguments dialog box provides a description of 
the function and a description of each of the function’s arguments. When you fill in the 
arguments, the result of the formula is displayed above the function description in the 
dialog box.

Tip You can insert functions in Excel two additional ways. The Insert Function button 
(fx) appears both on the Formulas tab and in the formula bar. Select a category and 
scroll through the list of functions for a description of each one, or enter keywords in 
the Search For A Function box. 

After a function is inserted in a cell, double-click the cell (or click in the formula bar) to 
edit the formula, which activates a number of helpful tools. When you click anywhere in 
the function in a cell or in the formula bar, a ScreenTip appears, showing you the correct 
syntax and displaying the currently selected argument in bold. If you click the function’s 
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name in the ScreenTip, the Help window opens, displaying a topic that describes the  
function. Also, the formula’s dependent cells are surrounded by colored borders on  
the sheet; drag the borders or resize them to change the cells used as arguments.

Using nested functions 
Functions are said to be nested when the parenthetical expression following the function 
name contains another function. A nested function performs a subordinate calculation 
to provide an argument for another function. For example, in the simple nested formula 
=INT((SUM(B2:B5), the SUM function calculates the total first, and then the INT function 
rounds the result to the nearest integer. 

In the formula =INT((SLN(SUM(B2:B5),0,5), the SUM function provides an argument (cost) 
for the SLN function (five-year straight-line depreciation), which becomes the argument for 
the INT (integer) function. You can create up to 64 levels of nested functions.

Using the IF, AND, and OR functions
IF, AND, and OR are classified as logical functions in Excel. Logical operations seek a 
 result of either TRUE or FALSE (1 or 0), and are used to test for conditions by employing 
the logical operators =, <, >, >=, <= or <> to create conditional tests. For example, “if A 
is less than B, then C; but if not, then D” describes how the IF function works. The state-
ment “A is less than B” is a logical test, which can employ any one of the logical operators. 
For example, the formula =IF(B5<500, 12, 24) returns the value 12 only if cell B5 is less 
than 500 (TRUE); otherwise it returns the value 24. The following shows the syntax of 
these functions; non-italic text indicates required values.

=IF(logical_test, value_if_true, value_if_false)

=AND(logical1,logical2, …)

=OR(logical1,logical2, …)

The OR function returns TRUE if any of its arguments are true. The AND function returns 
TRUE only if all of its arguments are true. These two functions can be used alone, but are 
frequently nested within an IF function, which can also contain additional IF functions. If 
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either of the optional arguments value_if_true or value_if_false are left blank, the IF func-
tion returns a logical value: TRUE or FALSE.

Strategy The objective domain for Microsoft Office Specialist Exam 77-428 “MOS 
Excel Expert 2013, Part 2” includes “Utilizing the IF function in conjunction with other 
functions,” and “Utilizing AND/OR functions” as separate topics under Objective 3.1. 
Both topics are covered in this section.

Using the SUMIFS, AVERAGEIFS, and COUNTIFS functions 
The SUM, AVERAGE, and COUNT functions have useful “IF variants” that you can use to 
apply a criterion (one “if”) before tallying the results: SUMIF, AVERAGEIF, and COUNTIF. 
Similarly, you can use the “IFS variants” to apply multiple criteria (more “ifs”): SUMIFS, 
AVERAGEIFS, and COUNTIFS. The following shows the syntax of these functions; non-
italic arguments are required.

=SUMIF(range, criteria, sum_range)

=AVERAGEIF(range, criteria, average_range)

=COUNTIF(range, criteria)

=SUMIFS(sum_range, criteria_range, criteria, criteria_range2, criteria,...)

=AVERAGEIFS(sum_range, criteria_range, criteria, criteria_range2, criteria,...)

=COUNTIFS(sum_range, criteria_range, criteria, criteria_range2, criteria,...)

The SUMIF function adds values in the specified sum_range that match the criteria found 
in the range. For example (using named ranges instead of cell references for readability), 
the formula =SUMIF(Team,4,Sales) adds only those totals in the Sales column where 4 
appears in the Team column. 

Tip If the logical operator you need is an equal sign, you can simply enter the value 
alone as the logical test (4). However, when using a logical operator or text (other than 
a defined name) in a logical test, you must always enclose the expression in double 
quotation marks (">4").
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The SUMIFS function adds values in the specified sum_range that match the criteria 
 applied to the range. You can add up to 127 sets of criteria. 

Important The sum_range argument is the first argument in the SUMIFS function and 
the last argument in the SUMIF function. 

For example, the formula =SUMIFS(Sales,Team,4,Division,"Asia") adds only those totals in 
the Sales column where 4 appears in the Team column, and where Asia appears in the 
Division column.

The rest of the –IF and –IFS functions operate similarly.

l COUNTIF Counts the number of cells that match a single criterion

l COUNTIFS Counts the number of cells that match multiple criteria

l AVERAGEIF Averages the values in cells that match a single criterion

l AVERAGEIFS Averages the values in cells that match multiple criteria

Tip When using a SUMIFS, COUNTIFS, or AVERAGIFS function, all range arguments—the 
sum_range and each criteria_range—must have the same number of rows and columns.

➤	 To insert a function

 1. On the Formulas tab, in the Function Library group, click the Insert Function 
 button or any function category button, and then select the function you need.

 2. In the Function Arguments dialog box, enter the arguments for the function. 
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➤	 To	find	a	function

 1. On the Formulas tab, in the Function Library group, click the Insert Function 
button.

 2. In the Insert Function dialog box, in the Search for a function box, enter a descrip-
tion of the operation you want to perform. 

 3. To filter the list of functions, choose a category from the Or select a category list.

Using financial functions
Most financial calculations are performed by using the basics: addition, subtraction, mul-
ti plication, and division. Complex financial algorithms that involve multiple steps are 
packaged as functions. The functions that Excel provides in its financial toolbox fall into 
three major subcategories: investments, depreciation, and securities. 

You can find a wealth of information in the Help system about functions and how to use 
them; far more material than this book can cover. This section provides an overview of 
each subcategory and selects a few functions to examine in more detail.

See Also For information about working with international currencies, see section 2.4, 
“Prepare workbooks for internationalization and accessibility.”

Calculating investments
Investing is all about cash flow: how much, how often, for how long, and at what rate? 
These functions all perform similar calculations and share some of the same underlying 
algorithms. The investment functions in Excel include the value functions FV, PV, and 
NPV; the payment functions PMT, PPMT, IPMT; the rate functions RATE, IRR, and MIRR; 
and the periods function, NPER. The following shows the syntax of these investment 
functions; non-italic arguments are required.

l Present value =PV(rate, nper, pmt, fv, type)

l Future value =FV(rate, nper, pmt, fv, type)

l Net present value =NPV(rate, value1, value2,…)

l Payment =PMT(rate, nper, pv, fv, type)

l Principal payment =PPMT(rate, per, nper, pv, fv)

l Interest payment =IPMT(rate, per, nper, pv, fv)

l Rate of return =RATE(nper, pmt, pv, fv, type, guess)
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l Internal rate of return =IRR(values, guess)

l Modified internal rate of return =MIRR(values, finance_rate, reinvest_rate)

l Number of periods =NPER(rate, pmt, pv, fv, type)

Arguments common to the investment functions include those in the following table.

Argument Description
Fv (Future value) The value of an investment at the end of the term 

(0 if omitted)
Value1, value2, … A series of payments when the amounts differ
Nper Short for number of periods; the term of the investment
Pmt Short for payment; a series of payments when the amounts are 

the same.
Type Payment at the end of each period (0 or omitted), or the begin-

ning (1)
Per The period number of an individual period
Pv Short for present value; the value of an investment today
Rate Discount or interest
Guess A starting rate (10 percent if omitted)
Finance Rate The interest rate paid on borrowed money
Reinvest rate The interest rate received on invested money

The payment on a loan covers both the principal (the amount of the original loan) 
and the interest (the cost of borrowing money). In a fixed-rate loan, the payment 
stays the same over the loan term, but the principal portion increases each month, 
whereas the interest portion decreases. The functions you can use to dissect loans are 
PMT, which calculates a loan payment; PPMT, which returns only the principal portion 
of a payment for a particular period; and IPMT, which returns the interest portion. 

Tip When expressing periods, you must use the same units. For example, interest is 
usually expressed as an annual rate, but payments are usually made on a monthly basis. 
For example, if the units are months and you’re trying to figure out the annual interest 
rate, you would divide by 12 so that the units (months) match.

If you add an additional amount each month to scheduled payments, it is applied directly 
to the principal loan amount. This serves to reduce the number of periods necessary to 
repay the loan. You can see exactly what effect this will have on your payment sched-
ule by using the NPER function, which returns the number of periods required to pay 
off a loan. 
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Tip Payments are considered cash outflows, so the result of a payment function is always 
negative. If you don’t need the negative number for other calculations, you can display 
a positive payment amount by entering a minus sign between the equal sign and the 
function name in the formula, as in =-PMT(.4167,360,200000).

Calculating depreciation
Depreciation is a crucial tax calculation that allows businesses to spread tax deductions 
for major asset purchases over time, rather than having to expense them all in a single 
year. The United States Internal Revenue Service provides guidelines for the depreciable 
life of different classes of assets, and these are subject to change (see IRS.gov for details.) 
For example, cars are considered 5-year assets for tax purposes, whereas fruit trees are 
considered 10-year assets. 

The depreciation functions in Excel include the declining-balance depreciation functions 
DB, DDB (double-declining), and VDB (variable-declining); the straight-line depreciation 
function SLN; and the sum-of-the-year’s-digits depreciation function SYD. The following 
shows the syntax of the depreciation functions; non-italic arguments are required.

=SLN(cost, salvage, life)

=SYD(cost, salvage, life, per)

=DB(cost, salvage, life, period, month)

=DDB(cost, salvage, life, period, factor)

=VDB(cost, salvage, life, start_period, end_period, factor, no_switch)

Arguments common to the depreciation functions include those in the following table.

Argument Description
Cost The initial cost of the asset.
Life The depreciable life of the asset.
Period The period to be computed.
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Argument Description
Salvage The residual value of the asset after depreciation.
No_switch Used in the VDB function only. If omitted, the calculation switches 

to straight-line depreciation if the amount is greater than the 
 declining balance calculation. If TRUE, does not switch.

Straight-line depreciation is calculated by chopping the total cost into equal pieces after 
subtracting the salvage value (the estimated market value of the asset at the end of its 
depreciable life). 

When you calculate straight-line depreciation, however, the function returns the deprecia-
tion you can take for each period, which is the same for each period. The three declining 
balance methods (DB, DDB, and VDB) and the Sum-of-the-year’s-digits method (SYD) 
calculate depreciation at accelerated rates. These depreciation functions require you to 
specify a period number because the amount of depreciation differs in each period. 

Analyzing securities
Securities analysis is complex, and understanding the theories behind it is equally com-
plex. T-bills mature in one year or less, and do not pay periodic interest, only interest at 
maturity. T-notes mature in 2 to 10 years, pay a semiannual coupon amount, and come 
in denominations of $1,000. There are TIPS and STRIPS and zero-coupon bonds, US 
Savings bonds, corporate bonds, and other types of securities that use similar mecha-
nisms. Excel provides functions to massage them all. 

The securities-analysis functions in Excel are located on the Financial menu in the 
Function Library group on the Formulas tab, and perform the following types of 
calculations: 

l DOLLARDE and DOLLARFR Convert the typical fractional pricing of securities 
 between fractional and decimal values

l ACCRINT and ACCRINTM Calculate the accrued interest for securities that accrue 
on either a periodic basis or at maturity
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l INTRATE and RECEIVED Calculate either the interest rate or the total value at 
 maturity for fully invested securities

l PRICE, PRICEMAT, and PRICEDISC Calculate the price for securities per $100 of 
face value, for securities that pay periodic interest, interest at maturity, or are dis-
counted instead of paying periodic interest

l YIELD, YIELDDISC, and YIELDMAT Calculate the annual yield for securities that pay 
periodic interest, interest at maturity, or are discounted instead of paying periodic 
interest

l DISC Calculates the discount rate for a security

l TBILLEQ, TBILLPRICE, and TBILLYIELD Calculate yield, price, and bond-equivalent 
yield for US Treasury bills

l COUPDAYBS, COUPDAYS, COUPDAYSNC, COUPNCD, COUPNUM, and 
COUPPCD Calculate the number of coupons payable, and various associated dates 
and durations

l DURATION and MDURATION Calculate how bond prices responds to changes in 
yield

Arguments common to the securities analysis functions include those listed in the follow-
ing table.

Argument Description
Basis The number of days in a year, as calculated. Default is 0=US (NASD) 

30/360; 1=actual/actual; 2=actual/360; 3=actual/365; 4=European 
30/360.

Coupon The annual coupon rate of the security.

Frequency The number of coupon payments per year: 1=annual; 2=semiannual; 
3=quarterly.

Investment The amount invested in the security.
Issue The security’s issue date.
Maturity The date that the security matures.
Par The face value of the security.
Price The price of the security.
Rate The interest rate of the security; must be greater than or equal to 

zero.
Redemption The value of the security at redemption.
Settlement The settlement date (date of payment) for the security.
Yield The annual yield of the security.
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Tip A coupon, in bond terms, is an interest payment. Historically, bonds were physical 
certificates with tear-off coupons that you presented in exchange for a scheduled 
payment. This is where the term “coupon-clipper” originated. 

These are very specialized functions that both require and extract specific details about 
the security you’re investigating. For example, you can use the ACCRINT function to learn 
the amount of interest that has accrued by a security such as a US Treasury bond as of a 
certain date. 

➤	 To	insert	a	financial	function

 1. On the Formulas tab, in the Function Library group, click Financial, and then select 
the function you need.

 2. In the Function Arguments dialog box, enter the arguments for the function. 

Practice tasks

The practice files for these tasks are located in the MOSExcel2013Expert\Objective3 
practice file folder. Save the results of the tasks in the same folder.

l Open the ExcelExpert_3-1a workbook and try performing the following tasks:

m On Sheet1, insert a new column between columns G and H, and create a 
column of IF formulas that specify a different team and division.

m On Sheet2, copy the shaded area and paste a copy below it. Edit the six 
formulas (and the labels) to include only team numbers above 4.

l Open the ExcelExpert_3-1b workbook and try performing the following tasks:

m On the Periods worksheet, create a new formula to calculate the interest 
portion of payment number 175.

m On the Securities worksheet, create a new ACCRINTM formula by using 
a basis of 1.
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3.2 Look up data by using functions 
Lookup functions are data-mining minions. You use them to address tables of data, 
searching for a particular value to display or use in a formula. The Lookup and Reference 
menu on the Formulas tab includes 19 functions, but this section focuses on the top con-
tenders: LOOKUP, VLOOKUP, and HLOOKUP. The section also examines the TRANSPOSE 
function, which you use to flip vertically oriented data horizontal, and vice-versa. 

Using the VLOOKUP and HLOOKUP functions 
How to choose between the VLOOKUP and HLOOKUP functions depends upon how your 
table is organized. If your data is arranged in columns (labels on the left), use VLOOKUP. 
If your data is arranged in rows (labels at the top), use HLOOKUP. The following shows the 
syntax of these functions; non-italic arguments are required.

=VLOOKUP(lookup_value, table_array, col_index_num, range_lookup)

=HLOOKUP(lookup_value, table_array, row_index_num, range_lookup)

The table_array argument can be a range address or a name that defines the entire lookup 
table. The col_index_num and row_index_num arguments literally specify the column or 
row number in the table, counted from the top or left (including labels), from which to 
select the result. The lookup_value is the value that you want to match (approximately) in 
your table’s row or column of comparison values. 

Important LOOKUP, VLOOKUP, and HLOOKUP normally look for the greatest value that 
is less than or equal to the lookup value, not necessarily an exact match. For this reason, 
the table must be sorted in ascending order, on the row or column that contains your 
comparison values. For example, if your lookup_value is 1,000 and the largest comparison 
value is 500, then the function returns 500. If, instead, you need to find an exact match, 
set the optional range_lookup argument to FALSE (0). 

For example, the formula =VLOOKUP(410,B3:D7,3) looks in the first column of a 3 × 5 
table in the range B3:D7, finds the greatest value that is less than or equal to 410 (400), 
and returns Epsilon, the value found in the third column of the table.
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If you edit the formula to include a value of 0 (FALSE) as the optional range_lookup argu-
ment, as in =VLOOKUP(410,B3:D7,3,0), the result of the formula would be #N/A because 
there is not an exact match for 410 in the first column.

Similarly, the formula =HLOOKUP("Beta",A3:D8,3) looks in the first row of a 4 × 6 table 
in the range A3:D8, finds the greatest value that is less than or equal to Beta, and then 
returns the value found in the third row of the table. 

The text Beta happens to be an exact match. But if a text lookup value is not an exact 
match, the same rules apply. For example, if you misspell Beta in the previous formula 
to read =HLOOKUP("Bata",A3:D8,3), the result of the function is 10 instead of 101 be-
cause, alphabetically, Alpha is the greatest value that is less than or equal to the lookup 
value Bata.

Tip Uppercase and lowercase text are equivalent in lookup functions.
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Using the LOOKUP function 
You use the LOOKUP function primarily for one-dimensional lookup tasks—single rows 
or columns of data. You can also use LOOKUP with two-dimensional tables, but it always 
looks at the first row or column for the comparison value and selects the result from the 
same position in the last row or column. (You can specify any row or column by using 
VLOOKUP and HLOOKUP.)

The LOOKUP function has two forms. Use the vector form to return a value from a single 
row or column of data, or use the array form with either horizontally or vertically ori-
ented tables. The following shows the syntax of the two forms.

=LOOKUP(lookup_value, lookup_vector, result_vector)

=LOOKUP(lookup_value, array)

As with the other lookup functions, you must sort your table in ascending order on 
the row or column that contains the comparison value. For example, the formula 
=LOOKUP("Delta",B3:B7,E3:E7) specifies a lookup_vector and an optional result_vector 
(both must be the same size). If a result_vector is not specified, the result is pulled from 
the lookup_vector. 

The array form of the LOOKUP function automatically determines the orientation of the 
two-dimensional table specified by the array argument. If the table is wider than it is tall, 
LOOKUP searches the first row for a comparison value; if the table is taller than it is wide, 
(or square) it searches the first column. For most uses, it is best to use VLOOKUP or 
HLOOKUP, which allow more control and are easier to audit because the table orienta-
tion is indicated by the function name. LOOKUP is provided primarily for compatibility 
with other spreadsheet programs. 

Using the TRANSPOSE function 
The TRANSPOSE function does a seemingly simple thing (until you try to do it yourself): 
it flips the horizontal/vertical orientation of a selected range. 
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The tricks with this function are as follows:

l The formula must be entered as an array.

l Prior to entering the function, you must select a range to accept the transposed 
data that is exactly the same size as the source range, transposed. 

When you lock in an array formula, the formula is duplicated in all selected cells, and 
brackets appear around the formula in the formula bar. You cannot edit any individual 
cell in an array; you must edit all cells in an array together. If you try editing a cell, Excel 
displays an error message. To edit an array, double-click any formula, edit it, and then 
press Ctrl+Shift+Enter again. This changes all the formulas in the array at once. 

Tip You can also transpose by clicking the Transpose button on the Paste Special 
button of the Home tab. After you copy the range you want to transpose and select 
the cell where you want the transposed range to start, click the Transpose button. 
Excel determines the orientation of the selected cells, and pastes them in the opposite 
orientation.

➤	 To insert a TRANSPOSE function

 1. On the Formulas tab, in the Function Library group, click Lookup & Reference and 
then click TRANSPOSE.

 2. In the Function Arguments dialog box, specify the cell range you want to 
transpose. 

➤	 To transpose a selected cell range

 1. Copy the range you want to transpose, and then click the cell where you want the 
result to start.

 2. On the Home tab, in the Clipboard group, click the Paste Special button, and then 
click the Transpose icon in the Paste category.

Or

 1. Select a destination range that has exactly the same dimensions as the source 
range (transposed).

 2. Enter a formula by using the TRANSPOSE function, specifying the source range.

 3. Lock in the formula as an array by pressing Ctrl+Shift+Enter.
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➤	 To insert a LOOKUP function

 1. On the Formulas tab, in the Function Library group, click Lookup & Reference, 
and then click the function you want.

 2. In the Function Arguments dialog box, enter the function’s arguments. 

➤	 To enter an array formula

➜ Enter the formula, and then press Ctrl+Shift+Enter.

➤	 To edit an array formula

➜ Edit any formula in the array, and then press Ctrl+Shift+Enter.

Practice tasks

The practice file for these tasks is located in the MOSExcel2013Expert\Objective3 
practice file folder. Save the results of the tasks in the same folder. 

Open the Excel_3_2 workbook and try performing the following tasks:

l Edit the formula on the Vlookup worksheet so that the result is Beta.

l Edit the formula on the Hlookup worksheet so that the result is 98.

l On the Transpose worksheet, transpose the values in B10:F10.

3.3 Apply advanced date and time functions 
Date and time arithmetic has its own rules and syntax. In Excel (and in most modern 
computers), date and time counting begins at 12:00 AM on January 1, 1900, starting at 
1. January 2, 1900 is 2, and January 1, 2014 is 41640. Time is expressed as a decimal value 
expressing how much of the day has passed by. For example, the serial date 41640.50 is 
another way of saying “noon on New Year’s Day 2014.”

Tip You can change the date or time value displayed in a cell to a serial date value by 
applying the General format. Click General in the Number Format list in the Number 
group on the Home tab. Click Short Date or Long Date to change it back again.

Fortunately, you don’t have to enter dates that way, nor do you generally need to apply 
date or time formats. If you enter dates and times by using standard formats, Excel rec-
ognizes them and formats them automatically. For example, if you enter 1/11/14 into a 
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cell, Excel correctly assumes you have entered a date, and applies the equivalent of the 
Short Date format (on the Number Format list), displaying 1/1/2014; Excel just expands 
the year from 14 to 2014, so that there is no confusion about the century. But when you 
select the cell and look in the formula bar, Excel displays the full date and time, not a 
serial date value like 41640. In fact, regardless of any additional date or time formatting 
that you apply, the formula bar display stays the same. 

Using the NOW and TODAY functions 
The NOW and TODAY functions are as easy as it gets. Neither function takes a single 
argument; enter them, add a set of parentheses, and you’re done. When you enter 
=TODAY() into a cell, the current date is displayed; when you enter =NOW() into a cell, 
the current date and time are displayed. And yes, you must enter both parentheses, or 
Excel displays an error message. 

Both of these functions are volatile. This means that each time you open the workbook 
or edit a worksheet, the functions recalculate, displaying the date and/or time at that 
moment. Normally, formulas only recalculate when necessary; volatile functions recalcu-
late at every available opportunity. 

You can use these functions to insert starting dates or times into formulas that perform 
time-based calculations such as amortization or securities analysis. 
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Using functions to serialize dates and times 
When using date and time functions, Excel always calculates by using the precise under-
lying serial values. But when constructing formulas, you might need only the month or a 
specific time of day. Or you might need to convert imported dates that have been stored 
as text into dates that Excel recognizes. Excel includes a suite of functions you can use to 
address these tasks, and more.

Using the YEAR, MONTH, DAY, HOUR, MINUTE, and SECOND functions 
The YEAR, MONTH, DAY, HOUR, MINUTE, and SECOND functions each extract only the 
corresponding component of a date or time. They all accept just a single argument, 
which can be a reference to a cell that contains a date or time value, another date or 
time function, or a text date enclosed in quotation marks, as in =YEAR(“1/1/2014”). 

Using the DATEVALUE and TIMEVALUE functions 
The DATEVALUE and TIMEVALUE functions convert text dates and times into serial values, 
which is generally not necessary because Excel recognizes dates in most configurations. 
But sometimes they can come in handy when building formulas that use other formu-
las, or if you need to work with imported, unformatted text. Again, these functions take 
but a single argument, a reference to a cell that contains a date value, a date in text 
surrounded by quotes, or another date or time function. For example, the formula 
=DATEVALUE(“December 13, 2014”) returns the serial date value 41986. You can also 
use these functions to construct dates. For example, the formula =(DATEVALUE(C2&"-
"&C3&"-"&C1) returns a serial date value based on the values contained in the referenced 
cells (assuming they contain valid date values). A text-style date is constructed within the 
function by using cell references separated by dashes. In effect, the function first interprets 
the text, and then converts the date. 
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Concatenating text in formulas
Concatenation is the linking of characters or strings in a specific order to form a 
single string. The concatenation operator is the ampersand (&). You can use con-
catenation to construct arguments within a function, or to merge the contents 
of cells. The process is simple: when you want to add a string of text, enclose it 
in  ampersands. For example, the formula =(DATEVALUE(11&"/"&12&"/"&13) uses 
ampersands to construct the text string 11/12/13. Each number is connected by a 
&"/"& statement. The ampersand instructs Excel that what follows is to be inserted 
as text: if a cell reference, the cell value is inserted; if text, it must be enclosed in 
quotation marks. The concatenation operator can be used in formulas without 
functions as well. For example, if cell A1 contains the text Jelly and cell A2 contains 
the text Donut, the formula =A1&A2 returns the text string JellyDonut. To add a 
space, the formula =A1&" "&A2 does the trick. The space character must be enclosed 
in quotation marks, which is in turn enclosed in ampersands. You can also use the 
CONCATENATE function, which takes the form =CONCATENATE (Text1, Text2, …).

Using the WEEKDAY, WORKDAY, and NETWORKDAYS functions 
The WEEKDAY, WORKDAY, and NETWORKDAYS functions are helpful when calculating 
work or payroll schedules, planning projects, or even planning a vacation. The WEEKDAY 
function can be used to determine the day of the week for a specific date, and returns 
a value from 1 through 7. The function takes the form =WEEKDAY(serial_number, re-
turn_type), where serial_number is a date value or reference to a cell containing a date. 
Return_type is an optional argument indicating the way the days are counted. The de-
fault return_type is zero, indicating that 1=Sunday and 7=Saturday; a value of 1 indicates 
that 1=Monday and 7=Sunday; and a value of 3 specifies a number from 0 through 6, 
where 0=Monday and 6=Sunday. 
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Tip You can add or subtract days from a date by using + and – signs. For example, if cell 
B1 contains 1/1/2013, the formula =B1+1 returns 1/2/2013.

The WORKDAY function takes the form =WORKDAY(start_date, days, holidays) and returns 
a date that is a specified number of days before or after a given start_date, excluding 
weekends and (optionally) holidays. The NETWORKDAYS function counts the number of 
workdays between two dates, and takes them from =NETWORKDAYS(start_date, end_date, 
holidays). For both functions, holidays is an optional argument specifying a list of dates that 
you want to exclude.

The WORKDAY.INTL and NETWORKDAYS.INTL functions each take an additional 
 argument—weekend—that specifies alternate days of the week to use as nonwork 
days. A list of options appears when you select the weekend argument while editing 
the NETWORKDAYS.INTL function. Just click one of the 17 different combinations of 
weekend days (days off) to insert the corresponding number (for example, if you click 
the 7 - Friday, Saturday option, the number 7 is inserted into the function). 

Tip Your list of holidays would be best located on its own worksheet in the workbook.

➤	 To insert a NOW or TODAY function 

➜ On the Formulas tab, in the Function Library group, click the Date & Time button, 
click NOW or TIME, and then click OK.
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➤	 To insert a DATEVALUE or TIMEVALUE function

 1. On the Formulas tab, in the Function Library group, click the Date & Time button, 
and then click DATEVALUE or TIMEVALUE.

 2. In the Function Arguments dialog box, enter the text or reference you want to 
convert.

Practice tasks

The practice file for these tasks is located in the MOSExcel2013Expert\Objective3 
practice file folder. Save the results of the tasks in the same folder.

Open the Excel_3_3 workbook and try performing the following tasks:

l On the Work worksheet, create a new NETWORKDAYS.INTL formula where 
Sunday and Monday are considered weekends.

l On the Concat worksheet, create a new CONCATENATE formula that assem-
bles the words in column B into a sentence.

3.4 Create scenarios
In Excel, a scenario is a selection of cells that contain specific values you can save and 
reapply at any time. To create one, use the Scenario Manager, which is described later in 
this section. In a broader context, a scenario is a possible world; a collection of assump-
tions about the future; a guideline you can use to prepare for the worst case, the best 
case, or anything in between. Each line item in an annual budget could have multiple 
scenarios, for example, depending on the planners’ perception of what the future holds. 

This section first provides values with which to populate scenarios by using what-if analy-
sis tools. Then it describes how to consolidate data from multiple worksheets into one.

Strategy The objective domain for Microsoft Office Specialist Expert Exam 77-428, “MOS 
Excel 2013 Expert, Part 2” includes “Using financial functions” as a topic under Objective 
3.4. This topic appears in section 3.1, “Apply functions in formulas.”
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Using what-if analysis tools
By using built-in tools that appear on the What-If Analysis menu in the Data Tools group 
on the Data tab, you can calculate a value for a variable that helps you meet a goal, 
define and run scenarios, and test a range of values for one or two variables by using a 
data table. Also on the Data tab, the Solver add-in can be used to tackle larger models 
with multiple variables. 

Simply stated, what-if analysis is changing one or more variables in a data model to test 
a range of possible results. Suppose you want to predict an inevitable rise in the cost of 
materials by using a range of percentages, such as -2%, +5% or +15%, which can repre-
sent “best case, likely case, worst case.” Use what-if analysis to try different options, and 
use the Scenario Manager to keep track of the results. 

Using Goal Seek
The Goal Seek feature, which you access from the What-If Analysis menu in the Data 
Tools group on the Data tab, helps you obtain a specific result, using a single variable. In 
the Goal Seek dialog box, you point to a cell that contains a formula (called the set cell), 
enter the value you are seeking, and then specify the changing cell—the cell whose 
value Excel changes to meet the goal you define.

Tip If you work with what-if analysis tools, you’ll find it helpful to name cells and cell 
ranges rather than use cell references (for example, Revenue instead of $D$12). To name 
a cell or cell range, select it and then enter a name in the name box to the left of the 
formula bar. Names cannot include spaces and must be unique within a workbook. 

The Step and Pause buttons in the Goal Seek Status dialog box are enabled when Excel 
needs many calculation iterations to find the goal. Use the Pause button to pause the 
calculation, and click Step to proceed through each iteration one at a time.
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Enabling iterative calculations 
If you pose a particularly challenging goal-seeking problem, Excel might be un-
able to arrive at a precise solution, particularly if there are any circular references 
involved. Circular references are formulas that loop back on themselves through 
other formulas, which is usually not desirable, but is not uncommon in complex 
what-if models. Enabling iterative calculation can help. To do so, click Options in 
the Backstage view, and click Formulas. In the Calculation Options section of the 
Excel Options dialog box, select the Enable Iterative Calculation check box. The 
default but adjustable settings are 100 iterations with a maximum change value 
of .001. If, within the given number of iterations, Excel comes within the maximum 
change value of your goal, calculation stops and the result is displayed.

➤	 To identify a goal by using Goal Seek

 1. Select the cell that contains the formula you want to solve for.

 2. On the Data tab, in the Data Tools group, click What-If Analysis, and then click 
Goal Seek. 

 3. Enter your goal in the To value box. 

 4. In the By changing cell box, specify the cell where you want the result to appear.

Using Solver
Solver is designed to find an optimal value by manipulating multiple variables and com-
binations of variables. You can additionally specify multiple conditions that must be met 
in order to achieve a solution. 

In a Solver model, you need to define three basic elements:

l An objective or target, which is the value you want to optimize

l Changing cells, which are the values you can adjust to reach the objective

l Constraints, which are conditions that must be met in evaluating the model

For example, in a model projecting sales and cost of goods sold for a group of products 
who share a common production budget, one goal could be to find a balance between 
cost and sales volume that optimizes the production budget costs. If it were that simple, 
however, you could just sell a zillion units of your most profitable product; an unrealistic 
solution that an unconstrained optimization would likely produce. 
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So, you can use the Solver to keep everything within parameters, such as the following:

l The grand total of the product group’s cost of goods cannot exceed $150,000.

l The minimum projected sales per product is 50 units.

l No single product can consume more than 20 percent of the grand total.

l The cost of products 4 and 5 together cannot exceed $35,000.

l Projected sales must be expressed in integers.

Tip Before using the Solver, name the cells and cell ranges you’ll be working with, to 
make them easier to read and to work with.
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When you set up constraints, you can specify that a cell or cell range must be a whole 
number by choosing Int (integer) from the list of operators. You can specify Bin (binary) 
as the constraint type to set up yes/no decisions, or Dif to specify a constraint to indicate 
that all the values in the constrained cell or cells are different. In the Add Constraint dia-
log box, you can also enter values directly into the Constraint box.

Solver provides three options in the Select A Solving Method list in the Solver 
Parameters dialog box:

l GRG Nonlinear This is the default method, which applies to nonlinear problems 
whose points sit on a line that is curved.

l Simplex LP Use this method for straight-line problems.

l Evolutionary This method applies to problems whose elements do not fit on either 
a straight or curved line (that is, the elements are more random or discontinuous).

In the Solver Options dialog box, you can set options for solving limits (maximum time 
and number of iterations), that let you step through each iteration of Solver’s calculations 
(Show Iteration Results), and provides an option that controls the precision of values 
that are under constraints. The default value for precision is 0.000001. Changing the 
precision to a lower amount (closer to 1) might result in additional time needed to 
solve a problem. 

Important When the Solver Results dialog box appears on the screen, it might be in 
front of your data. The results are on the worksheet already, so take a look before you 
commit to keeping the results. You can drag the dialog box out of the way. If you click OK 
to keep the solution Solver arrived at, the results remain on the worksheet, and cannot be 
undone. 

When you save a workbook in which you have defined a problem for Solver, Excel saves 
the Solver information with the workbook. You can store one set of Solver parameters 
with each worksheet in a workbook; however, you can store and retrieve additional sets 
by clicking the Load/Save button in the Solver Parameters dialog box. 

Tip This section is a brief introduction to Solver. To learn more about the details of how 
to work with Solver and the type of problems it can analyze, see the chapters about 
Solver in Microsoft Excel 2010 Data Analysis and Business Modeling by Wayne Winston 
(Microsoft Press, 2010). You can also find information at www.solver.com.
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Using the watch window

In the watch window, you can keep an eye on critical formulas as you edit the work-
sheet. Rather than having to jump back and forth between locations on a worksheet 
or between workbooks, you can keep the formulas you need to see in view. 

Click the Watch Window command in the Formula Auditing group on the Formulas 
tab. Then select the cell or cells you want to keep an eye on. When you click Add 
Watch, Excel adds an entry to the watch window that lists the workbook, work-
sheet, cell reference, value, and any formula that’s defined in that cell. As you edit, 
the effects of your edits are reflected in real time in the watch window. You can 
also dock the watch window by dragging it to the top, bottom, or sides of the 
worksheet window.

Formulas that you add to the watch window are saved with the workbook, and 
continue to be available until you select them and click Delete Watch.

➤	 To load the Solver add-in

 1. In the Backstage view, click Options.

 2. In the Excel Options dialog box, click Add-Ins.

 3. In the Manage list, click Excel Add-ins, and then click Go.

 4. In the Add-Ins dialog box, select the Solver Add-in check box, and then click OK.

➤	 To set up Solver parameters

 1. On the Data tab, in the Analysis group, click Solver.

 2. In the Solver Parameters dialog box, specify the Set Objective cell.

 3. In the To area, select Max, Min, or Value Of. If you choose Value Of, enter a value.
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 4. In the By Changing Variable Cells box, specify the cells whose values Solver can 
change when analyzing the data.

 5. In the Subject to the Constraints area, click Add, and then define the constraint 
in the Add Constraint dialog box. Click Add in the Add Constraint dialog box to 
define another constraint. Click OK when you finish defining constraints.

 6. Click Solve.

Using the Scenario Manager
To manage your what-if models so that you recall them instantly, use the Scenario 
Manager. You can create multiple scenarios by using the same model, for example, Best, 
Most Likely, or Worst Case. Each scenario can store values for up to 32 changing cells. 
For example, after making changes to a Solver model, you could save the result as a 
 scenario named Solved.

You define a scenario by specifying changing cells, whose value you want to record when 
you’re done. Excel displays the Scenario Values dialog box, in which the current value is 
displayed for each of the changing cells you selected.

Tip Consider selecting your changing cells before performing any analysis, and save them 
as a scenario named something like Beginning or Original. This makes it easy to start over 
if you don’t like the results. 

To edit a scenario, select it in the Scenario Manager and click Edit. Make any changes in 
the Edit Scenario dialog box and the Scenario Values dialog box, where you can modify 
the values for each changing cell directly. 

Click the Show button in Scenario Manager to insert the values for the selected scenario 
in the worksheet. 



112  Chapter 3 Create advanced formulas

Merging scenarios
You can distribute a workbook, have other people define scenarios in their copies 
of the workbook, and then merge them all into a single workbook. With the work-
books that contain scenarios open, click the Merge button in the Scenario Manager 
dialog box. In the Merge Scenario dialog box, select the workbook that contains 
the scenarios you want to merge. 

➤	 To	define	a	scenario	and	then	view	the	results

 1. On the Data tab, in the Data Tools group, click What-If Analysis, and then click 
Scenario Manager.

 2. In Scenario Manager, click Add.

 3. In the Add Scenario dialog box, enter a name for the scenario.

 4. In the Changing cells box, specify each cell you want to alter, and click OK.

 5. In the Scenario Values dialog box, enter the values for each changing cell.

 6. Click Add to define another scenario, or click OK to return to the Scenario 
Manager dialog box.
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➤	 To see the results of a scenario

➜ In the Scenario Manager dialog box, select a scenario and click Show.

➤	 To edit a scenario

 1. In the Scenario Manager dialog box, select a scenario, and then click Edit.

 2. In the Edit Scenario dialog box, change the scenario name or alter the list of 
changing cells. Then click OK. 

 3. In the Scenario Values dialog box, modify the values of changing cells.

➤	 To delete a scenario

➜ In Scenario Manager, select a scenario, and then click Delete.

Consolidating data
You can use the Consolidate command in the Data Tools group on the Data tab to com-
bine values from up to 255 worksheets into one master worksheet. The source worksheets 
can be from the same workbook or from other workbooks, and the consolidation settings 
are saved so that you can rerun it at any time. You can consolidate data in two ways:

l Consolidation by position Using this command is the easiest way to consolidate, 
but the cell ranges in all supporting worksheets must be the same size with identi-
cal row and column labels in identical locations. 

l Consolidation by category By using this command, you can collect data from sup-
porting worksheets whose cell ranges are different sizes, but use the identical row 
and column labels in different locations.

Consolidating by position
Suppose you have three worksheets containing sales data—Jan, Feb, and Mar—and you 
want to create a quarterly summary. The layout and labels are identical in all three work-
sheets. With all the supporting worksheets open, the first step is to select cells on the 
empty summary sheet where you want the consolidated data to go, without selecting 
the row or column labels. 
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In the Consolidate dialog box, you specify a cell range to consolidate by clicking a work-
sheet tab (or a tab in another workbook) to activate it, and then dragging to select cells. 
References are inserted in the dialog box. In a consolidation by position, you shouldn’t 
need to select cells again, just the worksheet tab, because Excel selects the same range 
of cells specified in the first consolidation reference. 

Tip If you select row or column labels, click Use Labels In in the Consolidate dialog box 
so that the consolidated result includes them.
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Repeat this process for each worksheet until all the cell ranges you want to consolidate 
are represented in the All References box. Consolidation data is saved with the work-
book, so that the next time you use the Consolidate command, you can rerun the same 
consolidation immediately. 

Tip You can add sheets to a consolidation from other workbooks, but if they are not 
open you’ll have to type external cell references from memory, including the full path 
to the folder. If you aren’t working with too many sheets, hold down the Ctrl key while 
dragging a copy of each sheet into one workbook, and then run the consolidation there.

Consolidating by category
Suppose you have three similar worksheets you want to consolidate, but each contains 
different data in the rows and columns. This time when you consolidate, you’ll include 
the labels from your source worksheets. The first step in this case is to select a single cell 
on the summary worksheet where you want the consolidated data to start. Make sure 
there is room; give the summary its own worksheet and you won’t have to worry.

This time on the summary worksheet, just select a single cell specifying the upper-left 
corner of the result range. The consolidation will pull in values and the labels from the 
source worksheets. The Consolidate command uses the labels from each source sheet to 
put the results in the right places. If the row or column labels match, Excel adds the val-
ues together; if they are different, Excel adds another row or column. 



116  Chapter 3 Create advanced formulas

In the Consolidate dialog box, you’ll need to select each range manually to ensure that 
all the data you need makes it into the summary, because all the cell ranges are different 
sizes. Make sure to include both the row and column labels in all the selections. 

Tip The consolidations discussed in this section are static; if the source data changes, 
you’ll need to rerun the consolidation. But you can create a dynamic consolidation that 
updates automatically by clicking Create Links To Source Data in the Consolidate dialog 
box, which inserts reference formulas in your summary worksheet.

➤	 To consolidate data by position 

 1. Open the workbook or workbooks to consolidate.

 2. On the summary worksheet, select the range that will contain the consolidated 
data. This range and all the source ranges must be the same size, and all must have 
identical row and/or column labels.

 3. On the Data tab, in the Data Tools group, click the Consolidate button.

 4. Select the function that you want to apply, and then click in the Reference box.

 5. Click the first worksheet tab you want to add, select the data you want to con-
solidate, and then click the Add button. Repeat for each worksheet you want to 
consolidate.

 6. Select options for labels and links, if necessary.

 7. Click OK.
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➤	 To consolidate data by category

 1. Open the workbook or workbooks to consolidate.

 2. On the summary worksheet, select the cell in the upper-left corner of the range 
that will contain the consolidated data.

 3. On the Data tab, in the Data Tools group, click Consolidate.

 4. Select the function that you want to apply, and then click in the Reference box.

 5. Click the first worksheet tab you want to add, select the data you want to con-
solidate, and then click the Add button. Repeat for each worksheet you want to 
consolidate.

 6. Select options for labels and links, if necessary.

 7. Click OK.

Practice tasks

The practice files for these tasks are located in the MOSExcel2013Expert\Objective3 
practice file folder. Save the results of the tasks in the same folder.

l Open the ExcelExpert_3-4a workbook and on the Goal Seek worksheet, find a 
price that would yield revenue of $125,000.

l Open the ExcelExpert_3-4b workbook and run the Solver; increase the cost 
of goods for products 4 and 5 by 10 percent and save the result as a new 
scenario.

l Open the ExcelExpert_3-4c workbook and consolidate values by position from 
the Jan, Feb, and Mar worksheets on the Summary sheet.

l Open the ExcelExpert_3-4d workbook and consolidate values by category 
from the Jan, Feb, and Mar worksheets on the Summary sheet. Add fake data 
to any or all of the month worksheets and rerun the consolidation.

Objective review
Before finishing this chapter, ensure that you have mastered the following skills:

3.1 Apply functions in formulas
3.2 Look up data by using functions
3.3 Apply advanced date and time functions
3.4 Create scenarios
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Index
Numbers and Symbols
" " (quotation marks), in logical tests, 88
# (number sign), in format coes for numbers, 3
% (percent sign), in format codes for numbers, 3
& (ampersand), concatenating with, 103
* (asterisk), in format codes for numbers, 4
, (thousands separator), in format codes for 

numbers, 4
. (decimal point), in format codes for numbers, 3
= (equal sign), in logical tests, 88
? (question mark), in format codes for numbers, 3
@ (at symbol), in format codes for numbers, 4
\ (backslash), in format codes for numbers, 4
_ (underscore), in format codes for numbers, 4
0 (zero), in format codes for numbers, 3

A
accepting changes, 29
Access, importing data from, 9, 11
Accessibility Checker, 36, 37, 38
accessibility, preparing workbooks for, 36
accounting number formats

creating custom, 7
dollar signs in, 6
syntax for, 5

ACCRINT function, 93
ACCRINTM function, 93
activating

relationships, 145
sheet protection, 17

add-ins, Solver, 110
aligning dollar signs, 6
aligning numbers by using formatting characters, 

4, 5
alt text (alternative text), 37, 38
amortization

calculating, 91
time-based calculations and, 101

ampersand (&), concatenating with, 103
AM/PM, codes for formatting, 10
AND function, 87
animations, in PivotCharts, 150
arguments

defined, 86
col_index_num, 96

criteria_range, 89
for investment functions, 91
lookup_value, 96
lookup_vector, 98
range_lookup, 96
result_vector, 98
return_type, 103
row_index_num, 96
securities analysis, 94
serial_number, 103
sum_range, 89
table_array, 96
value_if_false, 88
value_if_true, 88
weekend, 104

array formulas, 99, 100
asterisk (*), in format codes for numbers, 4
at symbol (@), in format codes for numbers, 4
auditing formulas, 37
AutoCorrect options, 40
AutoFill capabilities, 13
AutoRecover, 4, 5
AVERAGEIF function

purpose, 89
syntax, 88

AVERAGEIFS function
purpose, 89
syntax, 88

axis, secondary value, 123

B
backslash (\), in format codes for numbers, 4
bar charts, conditional formatting for, 15
blank cells, accessibility and, 38
body style, fonts for, 43
breaking external references, 13
buttons, inserting, 33

C
calculated fields and items, 136, 137
calculating

depreciation, 92, 93
investments, 90
loan payments, 91
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calculations
checking for errors, 34
current workbook, 25
current worksheet, 25
iterative, 24, 25, 107
options, 23, 25
overview, 23
subordinate, in nested functions, 87

captioning, accessibility and, 38
cardinality, hierarchies and, 145
categories of metadata, 22
cell ranges

constraints and, 109
naming, 106, 108

cell styles
colors, 26
creating, 26
custom, 5
modifying, 26
overview, 25

cells
constraints and, 109
naming, 106, 108

change history log, 15, 16
change tracking

accepting revisions, 29
displaying all, 29
exclusions, 15
history log, 15, 16
options, 14, 16
overview, 14
passwords and, 15
rejecting revisions, 29
reviewing changes, 29
scope, 15
sharing and, 15
tables and, 15
turning off, 17
turning on, 16

charts
bar, conditional formatting for, 15
drop lines, 122
high-low lines, 122
overview, 119
secondary axis, 123
templates for, 127, 128
trendlines, 120, 121, 122
type, changing for secondary axis, 126
up-down bars, 122

check box form control, 31, 34, 35
checking accessibility features, 36, 38

checking spelling, in other languages, 41
circular references, 24, 107
clearing conditional formatting rules, 22
codes. See format codes
color scales, 16
color schemes

PivotCharts and, 153
templates and, 26

color sets
custom, 27, 28
managing multiple, 43

columns, 142
combo box form control, 31, 34
command button form control, 31, 35
comments, 30
CONCATENATE function, 103
concatenating text in formulas, 103
conditional formatting

applying, 18
applying multiple on same cells, 20
clearing all rules, 22
color scales, 16
custom, 16, 18
data bars, 15, 17, 18
editing rules, 22
formulas, 18, 19
highlight cells, 15, 16
icon sets, 16
managing rules, 21, 22
overview, 15
PivotTables options, 20
rule categories, 15
rule types, 17
top/bottom, 15, 16

conditional tests. See logical functions
configuring change tracking options, 16
connecting tables, 142
connections, data. See importing data
consolidating data

adding sheets, 115
by category, 113, 115, 116, 117
by position, 113, 114, 115, 116
dynamic, 116
overview, 113
rerunning, 116

constraints, in Solver models, 107, 109
controls, adding alt text to, 38
copying

macros, 7
styles, 5, 7

corresponding field, scoping by, 20
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COUNTIF function
purpose, 89
syntax, 88

COUNTIFS function
purpose, 89
syntax, 88

COUPDAYBS function, 94
COUPDAYS function, 94
COUPDAYSNC function, 94
COUPNCD function, 94
COUPNUM function, 94
coupons, bonds and, 95
COUPPCD function, 94
.csv files, passwords and, 25
custom

cell styles, 26
chart templates, 127
color sets, 27, 28
conditional formats, 16, 18
date formats, 7, 8, 9
fill sequence, 13, 14
font sets, 27, 28
number formats, 2, 7
styles, copying between templates, 5
templates, 23, 24
themes, 29
time formats, 9, 10, 11

D
data bars

conditional formatting, 15
negative values in, 17
options, 18

Data Connection Wizard, 10
data connections. See importing data
data, consolidating, 113, 114, 115, 116, 117
data mining. See lookup functions
data models

cell styles and, 25
importing data, 140, 142
PowerPivot and, 139
vs. tables, 142
tables, adding to, 141, 142
as virtual data cubes, 140
what-if analysis and, 106

data series, adding multiple to the same chart, 125
date formats, custom, 7, 8, 9

dates
functions for calculating. See functions
holidays, including in calculations, 104
how Excel calculates, 7, 100
weekends, including in calculations, 104

DATEVALUE function, 102, 105
DAY function, 102
days of the week, functions and, 103
DB function, 92
DDB function, 92
deactivating relationships, 145
decimal point (.), 3
declining balance depreciation, 92, 93
deductions, calculating depreciation for, 92
default storage location for templates, 3
deleting

chart templates, 128
custom formats, 7
hierarchies, 148
relationships, 145
scenarios, 113
trendlines, 123

dependent cells, viewing, 87
dependents, tracing, 36, 37
depreciation, 92, 93
Developer tab, displaying, 7
digits, controlling number of on each side of 

decimal point, 3
DISC function, 94
display language, 40
displaying

all tracked changes, 29
change tracking, 28
comments, 30
data in international formats, 39
Developer tab, 7
formulas, 36
on-screen keyboard, 43
startup prompt when updating external 

references, 13
distributing copies, 31, 32
#DIV/0!, 33
Document Inspector, 22
DOLLARDE function, 93
DOLLARFR function, 93
dollar signs, aligning, 6
drop lines, 122
dual-axis charts. See secondary axis charts
DURATION function, 94



E
editing

changing language for, 40
conditional formatting, 22
formatting rules, 17, 18, 19, 21
formula links, 10
functions, 86
hierarchies, 145, 148
relationships, 144
restrictions, 17, 18, 19
scenarios, 111, 113
themes, 29, 30

elapsed time format, codes for, 11
encrypting

with passwords, 26
workbooks, 25

equal sign (=), in logical functions, 88
errors

in calculations, 34
dependents, tracing, 36, 37
in formulas, 33
manually checking for, 35
precedents, tracing, 36, 37
tracing, 35, 37
turning off checking for, 34, 35
values that appear in cells, 33

evolutionary solving method, 109
Excel Data Model, 9, 139
Excel Services, 8, 12
Excel Solver. See Solver
existing connections, importing data from, 10, 12
exponential trendlines, 120
exponents, format codes for, 4
extending a series, 11
external references, 13

F
FALSE, result of logical operation, 87, 88
fields

calculated, 136, 137
headers, 134
PivotTable, 131, 132, 149

files, encrypting, 26
filling a series

linear vs. growth, 12
nonnumeric, 13
options, 11
procedure, 14

filtering data, 134, 135
filtering PivotCharts, 151, 152

final, marking as, 26, 27
financial functions. See also international formats

inserting, 95
overview, 90

finding functions, 90
font sets, custom, 27, 28
forecasting. See trendlines
foreign key, 142
format codes

for dates, 7, 8, 9
for numbers, 2, 3, 4, 5

formatting
conditional. See conditional formatting
form controls, 32
PivotCharts, 150
PivotTables, 133, 134
slicers, 138

form controls
check box, 31, 34, 35
combo box, 31, 34
command button, 31, 35
formatting, 32
group box, 32, 33, 34
inserting, 30, 33
label, 32, 35
list box, 31, 34
option button, 31, 34, 35
overview, 30
scroll bar, 31
setting properties, 35
spin button, 31, 34

formulas
array, 99, 100
circular references in, 24
concatenating text in, 103
conditional formatting and, 18, 19
displaying, 36
errors, indentifying, 33
errors in, identifying, 33, 34
hiding, 17
inconsistent with adjacent cells, 34
links, editing, 10
manually checking for errors, 35
removing auditing arrows, 37
tracing errors, 35, 36, 37
turning off error checking, 34
viewing dependent cells, 87
viewing with watch window, 110

fractions, format codes for, 4
functions

AND, 87
arguments, 86, 88, 89
AVERAGEIF, 88, 89
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AVERAGEIFS, 88
conditional formatting and, 18, 19
COUNTIF, 88
COUNTIFS, 88, 89
date and time, 100, 101
DATEVALUE, 102, 105
DAY, 102
depreciation, 92
editing, 86
finding, 86, 90
HLOOKUP, 96, 97
IF, 87
inserting, 86, 89
investment, 90
library of, 85
LOOKUP, 98
nested, 87
NETWORKDAYS, 103, 104
NOW, 101, 104
OR, 87
securities analysis, 93
SUMIF, 88
SUMIFS, 88
TIMEVALUE, 105
TODAY, 101, 104
TRANSPOSE, 98
VLOOKUP, 96, 97
volatile, 101
WEEKDAY, 103
WORKDAY, 103, 104
WORKDAY.INTL, 104

fundamental tasks in Excel, not covered in this 
book, 1

future value function, 90

G
Goal Seek

identifying goal using, 107
overview, 106

Goal Seek command, 24
GRG Nonlinear solving method, 109
group box form control, 32, 33, 34
growth series, 12

H
heading style, fonts for, 43
Help, configuring language for, 40
hiding formulas, 17
hierarchies

adding to PivotTables, 146
cardinality and, 145
creating, 146, 147
deleting, 148
editing, 145, 148
overview, 145
renaming, 147

highlight cells
conditional formatting rules, 15
modifying default formats, 16

high-low lines, 122
HLOOKUP function, 96, 97
holidays, calculating dates and, 104
HOUR function, 102
hours, codes for formatting, 10
hyperlinks, accessibility and, 38

I
icon sets, conditional formatting, 16
IF function, 87
IF statements, circular references and, 24
images, adding alt text to, 38
importing data

from Access, 9, 11
into data model, 140, 141
Excel Data Model and, 9
existing connections, 10, 12
from other sources, 10
overview, 8
relationships and, 142
from SQL Server, 10
from text, 9, 11
from web, 9, 11
XML, 10

inserting
change history log as new worksheet, 16
DATEVALUE function, 105
financial functions, 95
form controls, 30, 33, 34
functions, 86, 89
international symbols, 43
LOOKUP function, 100
NOW functions, 104
PivotCharts, 149
scenarios, 111
slicers, 138
TIMEVALUE function, 105
TODAY functions, 104
TRANSPOSE functions, 99

inspecting workbooks, 21, 22, 38
installing PowerPivot, 139, 141
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interest, calculating accruals, 95
interest payment (IPMT) function, 90
interface text, changing language for, 40
international formats, displaying data in, 39
internationalization, preparing workbooks for, 36
international symbols, 42, 43
INTRATE function, 94
investment functions, 90, 91
items, calculated, 136, 137
iterative calculations

defined, 24
enabling, 107
setting maximum, 25

K
keyboard

changing layout language for, 42
on-screen, displaying, 43

L
label form control, 32, 35
language pairs, 41
languages

additional, installing, 39
changing, 39, 41
checking for installed, 41
downloading additional, 41
for editing, 40
enabling, 41
keyboard layout, changing for, 42
for proofing, 40, 41
spell check for each, 41
translating, 42

linear series, 12
linear trendlines, 120
linking formulas, 10
links

breaking, 13
updating, 10, 13

list box form control, 31, 34
literal character strings, format codes for, 4
literal demarcation characters, format codes for, 4
loan payments

calculating, 91
time-based calculations and, 101

locking worksheets, 17, 18
logarithmic trendlines, 120
logical functions, 87, 88
logical operators, 87, 88

lookup functions
HLOOKUP, 96
LOOKUP, 98, 100
overview, 96
sorting, 98
TRANSPOSE, 98, 99
VLOOKUP, 96

M
macros

copying, 7, 8
enabling, 7
overview, 7
recording, 7
security, 7
slicers and, 138

manual
calculations, 23
error checking, 35

marking as final, 26, 27
Maximum Change setting, 24
MDURATION function, 94
merged cells, accessibility and, 38
merging

scenarios, 112
styles, 6
workbooks, 31, 32, 33

metadata
categories, 22
overview, 21
vs. properties, 22
removing, 36

Microsoft Query, connecting to data, 10
Microsoft SharePoint, Excel Services and, 8
Microsoft SQL Server, connecting to, 10
Microsoft Translator, 41
Microsoft Visual Basic for Applications (VBA), 

copying macros and, 7
MINUTE function, 102
minutes codes for formatting, 10
MONTH function, 102
moving average trendlines, 120
multiple tables, analyzing, 9

N
#N/A, 33
#NAME?, 33
naming

cells and cell ranges, 106, 108
columns, for accessibility, 38
worksheets, for accessibility, 38
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navigating, error tracing, 36
nested functions, 87
net present value (NPV) function, 90
NETWORKDAYS function, 103, 104
NETWORKDAYS.INTL function, 104
nonnumeric series, filling, 13
NOW function, 101, 104
#NULL!, 34
#NUM!, 34
numbers

aligning, 4
customizing display of, 3

number sign (#), in format codes for numbers, 3
numeric formatting, 2, 3, 4, 5

O
objects

adding alt text to, 38
tab order, 33

on-screen keyboard, displaying, 43
option button form control, 31, 34, 35
OR function, 87
Oracle, connecting to, 10
overwriting same-named styles, 6

P
passwords

encryption and, 25, 26
file formats and, 25
options, 26
protecting workbooks, 18
removing encrypting, 26

Pause button, Goal Seek and, 106
payment (PMT) function, 90
payments for loans, calculating, 91, 92
percent sign (%), in format codes for numbers, 3
percentages, fomat codes for, 3
periods

for depreciation calculations, 93
for forecasting with trendlines, 122
for loan payments, 91

permissions, enabling for specified cells, 19
PivotCharts

analyzing, 150, 151
animations in, 150
changing colors, 153
creating, 149, 151
Data Model and, 9
designing, 150
filtering, 151, 152

formatting, 150
inserting, 149
overview, 148
PivotTables and, 149, 150
rearranging, 149, 152
sorting, 152
styles, applying to, 152, 153

PivotTables
calculated fields and items, 136, 137
compact format, 133
conditional formats and, 20
creating, 143
Data Model and, 9
field headers, 134
field list, 131, 135, 149
field settings, 132, 133
filters, applying, 134
formatting, 133, 134
inserting, 133
modifying, 139
outline format, 133
overview, 129
PivotCharts and, 149, 150
recommended, 129, 130
slicers, 137, 138
tabular format, 133

placeholders
for digits, 3
for text, format codes for, 4

polynomial trendlines, 120
power trendlines, 120
Power View Reports, Data Model and, 9
PowerPivot

Data Model and, 9
editions available in, 139
hierarchies, 145, 146, 147
installing, 139, 141
launching, 141
loading data into, 139
overview, 139
relationships and, 142

precedents, tracing, 36, 37
prerequisite skills and experience for this exam, 

1, 2
present value function, 90
PRICE function, 94
PRICEDISC function, 94
PRICEMAT function, 94
principal payment (PPMT) function, 90
proofing, changing language for, 40, 41
properties

for form controls, 35
vs. metadata, 22
workbook connections, viewing, 13
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protecting workbooks
current worksheet, 20
encryption, 25, 26
locking and unlocking, 18
marking as final, 26, 27
overview, 17
recommending read-only, 27
sharing and, 21
structure, 20

Q
question mark (?), in format codes for numbers, 3
quotation marks (" "), in logical functions, 88

R
ranges, naming, 106
rate of return (RATE) function, 90
read-only, recommending, 27
RECEIVED function, 94
recommended PivotTables, 129, 130
recommending read-only, 27
recording macros, 7
recovering versions of workbooks, 5
#REF!, 33
references, circular, 24
refreshing workbook connections, 12
regional date and time settings, 10
regression analysis, 120
rejecting changes, 29
relational databases, Data Model and, 9
relationships

defined, 142
activating and deactivating, 145
creating, 142, 143, 144
deleting, 145
editing, 144

removing
auditing arrows, 37
encryption, 26
metadata, 36
workbook connections, 12
workbook metadata, 21

renaming hierarchies, 147
repetition initiators, in format codes for 

numbers, 4
resolving conflicts in shared workbooks, 31
restoring workbooks, 5
restricting editing, 17, 19
results of scenarios, viewing, 112, 113

reviewing changes to a shared workbook, 29
revision marks. See change tracking
rounding, numeric format codes for, 3
R-squared value, 120

S
saving

charts as templates, 128
consolidation data, 115
Solver parameters in workbooks, 109
workbooks as templates, 4
workspaces, 20

Scenario Manager, 111, 112
scenarios

changing cells, 111
constraints and, 109
defining, 111, 112
deleting, 113
editing, 111, 113
Goal Seek and, 106
inserting, 111
iterative calculations and, 107
merging, 112
overview, 105
results, viewing, 112, 113
Solver and, 107, 108, 109
watch window and, 110
what-if analysis tools, 106

scientific notation, formatting numbers as, 4
scoping, conditional formatting rules and, 20
ScreenTips, setting language for, 40
scroll bar form control, 31, 34
SECOND function, 102
secondary axis charts, 123, 124, 125, 126
seconds, codes for formatting, 10
securities analysis functions

arguments, 94
overview, 93
time-based calculations and, 101
types, 93

security levels for macros, 7
selection, scoping by, 20
sequence, custom fill, 13
serial date values, 100, 101
series

fill options, 11
growth, defined, 12
linear, defined, 12

set cell, Goal Seek and, 106
shading, applying with conditional formatting, 

18, 19
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shared workbooks
accessibility and, 36
change tracking and, 15
comments and, 30
considerations, 14
distributing, 36
editing restrictions, 17
managing changes, 28
merging, 31
protection and, 17, 21
resolving conflicts, 31
reviewing changes, 29
tables and, 15

Simplex LP solving method, 109
Single Document Interface, 20
skills and knowledge assumed for this exam, 2
slash (/), in format codes for numbers, 4
slicer buttons, 2
slicers

clearing, 138
formatting, 138
inserting, 138
macros and, 138
modifying, 139
overview, 137

SLN function, 92
smoothing trendlines, 121
Solver

loading the add-in, 110
methods, 109
overview, 107
saving parameters in workbooks, 109
solving limits, 109

sorting data, 134, 135
sorting PivotCharts, 152
spell checking in other languages, 41
spin button form control, 31, 34
SQL Server, connecting to, 10
status, checking for external references, 13
Step button, Goal Seek and, 106
step values for a series, 12
straight-line depreciation, 92, 93
structure of workbooks, protecting, 20
styles

body, fonts for, 43
cells. See cell styles
copying between workbooks, 7
custom, 5
heading, fonts for, 43
merging, 6
PivotCharts, applying to, 152, 153

SUMIF function, 88
SUMIFS function

defined, 89
syntax, 88

sum-of-the-year’s-digits depreciation, 92, 93
SYD function, 92
symbols, international, 42, 43
syntax

AND function, 87
AVERAGEIF function, 88
AVERAGEIFS function, 88
COUNTIF function, 88
COUNTIFS function, 88
for date format codes, 8
depreciation functions, 92
HLOOKUP function, 96
IF function, 87
investment functions, 90
nested functions, 87
NETWORKDAYS function, 104
for number format codes, 5
OR function, 87
SUMIF function, 88
SUMIFS function, 88
for time format codes, 10
VLOOKUP function, 96
WORKDAY function, 104

T
tab order of objects, 33
tables

See also PivotTables
connecting, 142
data models and, 140, 142
overview, 119
relationships between, 144

targets, in Solver models, 107
tax calculations, depreciation, 92
TBILLEQ function, 94
TBILLPRICE function, 94
TBILLYIELD function, 94
templates

charts, 127, 128
color schemes, 26
copying styles between, 5
default storage location, 3, 24, 127
modifying, 24
online, creating workbooks from, 2
overview, 2, 23
protecting with passwords, 23, 24
saving, 23
saving workbooks as, 4
searching for, 2, 3

text
concatenating in formulas, 103
importing as data, 9, 11

text placeholders, format codes for, 4
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themes
creating, 29
custom, 29, 43
default storage location, 28
editing, 29, 30
merging styles and, 6
overview, 28

Thesaurus, 40
thousands separator (,), in format codes for 

numbers, 4
time

elapsed, format codes for, 11
formats, custom, 9, 10, 11
functions for calculating. See functions
how Excel calculates, 9, 100
regional settings, 10

TIMEVALUE function, 102, 105
TODAY function, 101, 104
top/bottom rules

modifying default formats, 16
overview, 15

tracing
dependents, 36, 37
errors, 34, 35
precedents, 36, 37

tracking changes
accepting revisions, 29
change history log, 15, 16
displaying all, 29
exclusions, 15
options, 14, 16
overview, 14
passwords and, 15
rejecting revisions, 29
reviewing, 29
scope, 15
sharing and, 15
tables and, 15
turning off, 17
turning on, 16

translating
options, 41
procedure for, 42

TRANSPOSE function
inserting, 99
overview, 98

transposing during paste operations, 99
trendlines

adding, 120, 122
chart types available for, 120
deleting, 123
effects, 121
forecasting with, 121, 122
formatting lines and arrows, 121, 122
options, 121

overview, 120
smoothing, 121
types, 120

troubleshooting formula errors, 35
TRUE, as result of logical operation, 87, 88

U
underscore (_), 4, 5
unlocking worksheets, 17, 18
unsaved workbooks, recovering, 5
updating links, 10, 13
up-down bars, 122

V
#VALUE, 33
value fields, scoping by, 20
VDB function, 92
versions of workbooks

managing, 4
recovering, 5

VLOOKUP function, 96, 97
volatile functions, 101

W
watch window, 110
web, importing data from, 9, 11
WEEKDAY function, 103
weekends, calculating dates and, 104
what-if analysis, 24, 106
workbooks

accepting and rejecting changes, 29
accessibility, 36, 38
calculating current, 25
calculations, 23, 25
connection properties, viewing, 13
connections, adding, 12
encrypting, 25
Excel Services, making available to, 12
inspecting, 21, 22, 38
locking, 17
macros, copying between, 7, 8
marking as final, 27
merging, 31, 32, 33
metadata, removing, 21
online templates, creating from, 2, 3
preparing for review, 14, 32
restricting editing on, 17
reviewing changes, 29
saving as templates, 4, 24
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sharing, 21
structure, protecting, 20
styles, copying between, 7
unlocking, 17
versions, retrieving, 4

WORKDAY function, 103, 104
WORKDAY.INTL function, 104
worksheets

calculating current, 25
protecting, 20

workspaces, saving, 20

X
.xltx file type, 23
XML, importing, 10

Y
YEAR function, 102
YIELD function, 94
YIELDDISC function, 94
YIELDMAT function, 94

Z
zero (0), in format codes for numbers, 3
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